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Representing Surfaces

Learning goals:  

1. Where should Sound Transit locate a new Park and Ride in the Thornton Creek Watershed area?

Files you need:

· Parcel.shp, lcodes.dbf, tcwvol.shp, thornton (a DEM file), and shedpr.shp on P:\ drive. See p. 2 of instructions for detailed pathnames.

Turn in:

1. Two maps per group:

a. One color hard copy map (without 3D imagery)

b. One soft copy map with 3D imagery (indicate where it is located on the S:\ drive) for review 

2. One group report explaining the site selection process and final determination.  Your report must clearly indicate all group members.

Tasks & Steps

In this project you will have the opportunity to work with several other students to engage in a site selection analysis and map design process. The project focuses on representing topography using a DEM but it also exposes you to some GIS-based mapping and spatial analysis, similar to that which is part of other GIS classes in Geography. Your group results will be evaluated collectively (i.e. each group member will receive the same grade).  The members of your group must be from your section or the other section meeting the same day as your own section (this is to make sure that all group members are working with the same TA). Be sure you have accurate contact information for all the members in your group.  If you are going to communicate via E-mail be sure to agree to check your messages daily at an agreed upon time.  You have more flexibility in this project than you have had in previous ones, so feel free to be creative while applying the principles of map design and cartography you have learned so far!  Because you are not given all of the ‘steps’ to create a map for this assignment, it will be helpful to refer to previous project instructions.  Before you begin this project, read the assignment carefully then form a team of two or three with your classmates. You may want to work with the same people in your Map Presentation group, but this is certainly not required. You may wish to delegate tasks to various group members to share the workload.

SOUND TRANSIT REQUESTS YOUR ASSISTANCE

The recent addition of several salmon species to the Endangered Species Act means that Sound Transit (ST) engineers and planners must ensure that improvements to the Puget Sound region’s transportation system do not adversely impact salmon habitats.  In order to improve transportation in the Puget Sound region, ST plans to add an additional Park and Ride to the Thornton Creek Watershed area. Your group has been sub-contracted by Sound Transit to locate a potential new Park and Ride location (though you may decide that existing Park and Ride lots are well-located).  The following criteria have been established by Sound Transit:

Site Selection Criteria

1. The Park and Ride must be on a lot that is currently vacant and larger than 100,000 square feet.

2. The Park and Ride should be located near (within 2,000 feet) roads that are projected to carry relatively high volumes of traffic (more than 50,000 cars per day) in the year 2010.

3. The new Park and Ride may be constructed as an extension of an existing one, or may be in a new location altogether. 

4. The Park and Ride should be located on a parcel of land that is relatively flat so that surface water run-off is easily captured and managed.  Further, a flat surface will make construction more cost effective and will minimize impacts to the surrounding environment; you’ll use ArcGIS’s 3D viewer, ArcScene for this portion of the analysis.

Data for regional studies such as this one are often difficult to obtain, as the various data layers involved are proprietary to various municipalities.  Sound Transit has done its best to provide you with the following information:

· A shapefile containing parcel level data (area, land use codes, tax payer information, etc.) for both the City of Seattle and the City of Shoreline (limited to the Thornton Creek Watershed area only): PARCEL.SHP (in P:\geog360s09\project6\data\communityInfrastructure\)

· A dBase file containing land use codes: lcodes.dbf (in P:\geog360a09\project6\data\)

· A shapefile containing street networks and traffic volume projections for the year 2010 (number of vehicles per day), limited to the Thornton Creek Watershed area: tcwvol.shp (in P:\geog360s09\project6\data\transportation\)

· A digital elevation matrix (DEM) based on 10 foot contours for the Thornton Creek Watershed: thornton (in P:\ geog360s09\project6\data\Thornton)

· A shapefile containing existing Park and Ride locations: shedpr.shp (in P:\ geog360s09\project6\data\transportation\)

GENERAL PROCEDURE

1. Select a small number of parcels that meet the first 3 Site Selection Criteria using ArcMap. There are no specific instructions for accomplishing this part of the process, so you must rely on the skills you have learned so far in the class.

Hints:

· Join the “lcodes” dBase file to the “parcel” shapefile to find the necessary data regarding land use.

· Use the ‘selection’ feature to find the suitable parcels. You should have 20 parcels in your selection with the criteria set above.

· Your hard copy map should include an inset map of WA State with King County highlighted, AND an inset map of king County with Thornton Creek watershed highlighted. (The data are available from project 5)

2. Use ArcScene to explore the Thornton Creek watershed in 3D. (See instructions below.) This will help you with Criterion 4.

3. Finally, put the two together at the end when you are ready to make your final site selection.

USING THE SELECT TOOLS IN ARCMAP

The Selection menu option in ArcMap has 3 main types of selection available, which, along with the Select Features tool in you Tools toolbar provide you with very powerful tools. The three options are: Select by Attributes, Select by Location and Select by Graphics. You can combine all these tools together to create nested selection, by using the options each tool provides. To achieve this, in each tool, you can choose a Method (in Select by Attributes)of selection (called “I want to” in Select by Location). You can create new selections, add or remove from a selection, and select within a current selection. In this lab assignment, a selection may be as follows:

1. Select parcels of specified size (selection 1) from all parcels

2. Select all vacant parcels (selection 2) from selection 1 (steps 1 and 2 can be combined)

3. Select all roads (selection 3) with specified traffic

4. Select all parcels from selection 2 within a distance from selection 3 (final selection)

There is no required way to do this, and steps can be nested in any way one finds it more useful. It may be wise for you to study the help provided with each selection type (by clicking the Help button).

WORKING WITH ArcScene AND 3D DATA MODELS

You will want to spend some time to become comfortable with ArcScene and using the 3D viewer independently of your initial work on the site selection problem.  You will of course have to combine the two forms of analysis for your final selection.  

Get the Spatial Analyst and 3D Analyst tools

1. Start the ArcMap application, begin with a blank map. 

2. Turn on the Spatial Analyst and the 3D Analyst tools by clicking on the Tools drop-down menu and choosing Extensions… 

3. Put checks in the boxes next to those extensions and then close the dialog box. 

4. Now you’ll need to put those tools on your screen: go to the View drop-down menu, choose Toolbars and put a check mark next to Spatial Analyst and 3D Analyst.  The new toolbars should appear on your screen. 

Acquire the Digital Elevation Matrix for the Thornton Creek Watershed

5. In ArcMap, click on the Add Data button. 

6. Navigate to the \project6\data\ folder, and double click on the Thornton Grid: to bring it in to ArcMap.  Notice what a Grid icon looks like in ArcGIS.  This elevation model was created by transforming (with ArcGIS) ten-foot contour lines into a Triangulated Irregular Network (TIN).  The TIN was then transformed (using ArcGIS) into a grid, which is what you are looking at.  The grid cells are approximately 150 feet by 150 feet. 

7. When you load it, the DEM should be drawn in black and white and looks almost like a photograph.  Notice the water network and how it seems to bleed into the land mass.  In the Table of Contents, you’ll see that the DEM has a high value of 550 and a low value of 20 – these are feet above sea level. To change the image from black and white to color, open the layer properties and select Symbology.  Choose a color scheme from the drop down menu for Color Ramp that makes sense to you.  Be aware that the low values represent water features, choose your colors accordingly.  Note that you can invert any color ramp by checking the Invert box located under the Histogram button (in the Symbology dialog box).  Notice the higher elevations off to the right side of the screen, what do you suppose those elevations represent? 

8. Open the Thornton Grid’s properties dialog box.  Click on the ‘Symbology’ tab.  Notice that where it says Show: on the left, Stretched is selected.  Click on classified.  What is the difference between the two methods? 

Make your layer semi-transparent (optional)

1. If you like, you can make your DEM semi-transparent so that you can see other layers more clearly.  In ArcMap, go to the layer properties dialog box.  

2. Click on the display tab. 

3. Where it says ‘transparent’ choose 50% as an experiment.  See what that does by clicking apply and adjust at will. 

View the DEM in the 3D Scene Viewer

1. Click on the ‘Launch ArcScene’ button on the "3-d Analyst" tool bar:  [image: image1.png]



2. Be patient while ArcScene loads.  

3. You’re going to copy the thornton DEM layer from ArcMap and paste it into ArcScene.  

4. In ArcMap, position your cursor over the layer name in the Table of Contents (thornton) and right click.  Select Copy.  

5. Go to ArcScene.  If the Table of Contents (called Scene Layers in ArcScene) does not automatically appear, go to the View drop-down menu and select Table of Contents.

6. Right click on Scene Layers in the Table of Contents and choose Paste Layer(s). Your DEM should appear in ArcScene. 

Add a third dimension to your view

Now we'll turn this flat view of the Thornton Creek watershed into a 3-D view. 

1. Open the layer properties in ArcScene for thornton, just as you would in ArcMap.  In the properties dialog box, click on the tab for Base Heights. Under Height, turn on the radio button that allows you to “Obtain height for layer from surface:” the path and file name for the DEM should appear in the box.  This function tells ArcScene to map all attributes according to the Z (height) values obtained in the DEM.  You can also add other layers to ArcScene (by copying and pasting as you just did) and laying them on top of your topographic model so that you can see them in 3D as well.  

2. In addition to obtaining your height from a surface, you will probably want to exaggerate your Z value as well.  By doing this, your elevation will be exaggerated so that you can see the topography better.  In the Z Unit Conversion area, where it says, “Apply conversion factor to place heights in same units as scene:” change the 1 to a 3 (you can always alter this later if you like).  This tells ArcScene to multiply all the Z values by 3.  Be sure that you record your Z conversion factor so that you can apply to other layers that you bring into ArcScene as well.  Your window should look like this:  
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3. Once you are finished, click ‘Apply’, then ‘OK’.   

4. Now you should see your DEM in 3D.  To navigate around, click on the navigate tool: [image: image3.png]


.  Hold the left mouse button and move the cursor to manipulate and explore the view.  Experiment with the other navigating tools and become familiar with the Thornton Creek Watershed topography.  

5. Now add another layer to ArcScene. To do this, follow the steps above – you’ll want to complete all of your symbolization in ArcMap and then copy and paste the layer into ArcScene.  Remember to open the layer properties for each layer that you add to set the base height and the Z conversion factor.  If you don’t do that, you will not be able to see your layer. 

6. Finally, save your 3D view. Go to the File drop-down menu, choose Save As. Be sure to navigate to the correct drive and folder.  Give your scene a name and note the file extension for a scene layer (.sdx).  You will need to include this file name in your final report (See Deliverables).

Calculate the slope from your DEM

In order to address Sound transit's criterion #4, you may want to calculate the slope for each cell in your raster DEM.  The slope measures the rise over the run (Δz/Δ(x,y) where Δ means ‘difference in’) or simply, how steep something is .  Location is described by the coordinates (x,y) in a two dimensional (horizontal) plane.  Elevation is noted by z along an axis perpendicular to both x and y axes (the horizontal plane).  Therefore, rise is a distance along the z axis representing the difference in elevation between two points located by pairs of x and y while run is the distance between the two locations measured in the horizontal plane.  When calculating the slope in a raster data set, ArcGIS takes the maximum rate of change in elevation over each cell and its eight adjacent neighbors.  Low slope values indicate flat terrain; as the slope value increases, so does the steepness of the terrain.

1. In ArcMap, click on the 3D Analyst drop-down menu.

2. Choose ‘surface analysis’ and click ‘slope’.

3. For the input surface, navigate to the thornton DEM that you have been working with.

4. Choose ‘degree’ or ‘percent’.  A 100% slope is a 45 degree slope because Δz = Δ(x,y).  Your choice will depend on how you want to talk about the slope, degree is probably more straight forward as it is easier to visualize (think of it in terms of an angle): [image: image4.png](597)



 
The slope of this angle is about 30 degrees (58%).

5. Leave the Z exaggeration factor and the cell size as they are.

6. Create an output raster – give the raster a name (such as TCslope) and be sure to put the raster you are creating in your personal file folder on the P: drive.

7. Click OK.This creates a new layer that is a raster indicating the slope for each grid cell.  This information may help you with your overall project goal.

INTERPRETING YOUR RESULTS

Now that you have created the maps you will need, work with your partners to analyze the maps and locate one parcel that meets all of Sound transits criteria. Make sure your final maps indicate this parcel clearly.

Remember that your 2-dimensional map should include two inset maps so that Thornton Creek watershed is easily identifiable.

Prepare your 3-D map so that it clearly shows the study area (Thornton Creek watershed) along with the other relevant layers.

When your maps are completed, discuss the following questions with your group in preparation for writing your report:

1. What is the geographical (spatial, temporal, and thematic) topic addressed in this assignment?

2. What geographical questions are relevant for this assignment? 

3. What issues/questions should be considering in any efforts to obtain data that address the geographical question(s) you identified in question 2?

4. How can we process the data to make it more understandable before we display it?

5. What map design issues (and in particular symbolization) should we consider when portraying geographic information? How did the map design decisions influence the “intended look” of the map?

6. What information do we now have regarding the topic that we did not have before we constructed our maps? Think of this information as new insight (based on generalizations) into the topic. If there is no new information, why not? Why have we been (or not been) successful with the map design in this assignment?

7. How did your maps and ArcScene help you determine acceptable sites for the new park and ride? Which sites have you chosen? Why? How do they satisfy the selection criteria?

The following questions are for GEOG560 students only:
8. Do the data category and the data measurement used in this lab assignment address the lab assignment objective? Why or why not?

9. How do the three realms of geographic information representation (worldview, database, and display) interact in this lab assignment?

10. If you had the opportunity to revise this assignment, what would you introduce, remove, or emphasize further?

When you finished discussing the above questions, collectively write a 2 to 3 page report (no more, please!) to Sound Transit that recommends your selected site and explains how your group analyzed the given data using GIS. Refer to the Essay Writing Guidelines while preparing this report. Also remember to proofread the report carefully for grammar and spelling mistakes! In your essay, be sure to include a description of the site including the present owner’s name if it can be determined.  Be sure that your report addresses all of the above questions and what you have learned about cartographic principles.

LAST STEP: Be sure all group member’s names and sections are on each item you turn in!



